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IBM WebSphere Host Publisher

Introductory Lab Material

Lab Instructions

Create Host Publisher Integration Object

Create Host Publisher Java Server Pages

Transfer Host Publisher application to server

Deploy Host Publisher application on the server

Access Host Publisher application from your desktop browser

Lab Instructions

Create a Host Publisher Host Access Integration Object

1. Start Host Publisher Studio
a. Navigate through the following:
1. Start
2. Programs
3. Host Publisher Studio
4. Application Integrator

2. Panel: Welcome to Host Publisher Application Integrator!
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a. Click Create Integration Objects

h_: Welcome to Host Publisher Application Integrator! il

Welcome to Host Publisher Application Integrator!
Bridging host data to the Internet

Lze this Aoplication Integrator for building & type of Java Bean called an Integration Object
Integration Objects encapsulate interactions with data sources like 3270 and 5250 applications
and databases, and retum desired data as Java Bean properties. These ahbjects are then
embedded within ¥Web pages, which allow people fo use a Web browser to interact with the data.

Click Create Integration Objects o build Integration ;
Objects for use in a Host Publisher application. L

Click Create Application to build a nevw Host
Publisher application using yaur Integration Objects.

Create Application

[ Don't show this dialog again,

Close

3. Panel: Create a new Integration Object
a. Select Host Access Integration Object
b. Click OK

Create a new Integration Object il

Selectthe type of Integration Ohject you wish to create.

[ Database Integration Object

(encapsulate a database transaction)

' Host Access Integration Ohject

(recard and encapsulate interactions with a host
application)

Ol [ Zancel
i

4. Panel: Welcome
a. Click Next

5. Panel: Integration Object
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a. On the Menu bar, select Options, and then select both Create EJB 1.1 Integration Object
Support, Create Web Services Integration Object Support, and Create Remote
Integration Object to automatically create the required support for EJB-enabled

Integration Objects, Web Services-enabled Integration Objects, and Remote Integration
Objects.

1} 1BM Host Publisher - Host Access iy _|o| x|
Filg Edit Macro Terminal EEGLEN Help

@l

Dbject Configuratians w ftarmatically Giniri.‘li Intggraion Obigcls on Save aflon Objact
» Prompt on Linracognized Scraans

il | Connacion Paols | Show Hiddan Fialds on Terminal in ibject orwork with an existing obiect Ifyou want to
- 4 Mew Integration Objer R P A p Push Sefined objects, of elick Browse 1o locate oher
’__ Connection Fool
'-"“:‘: E:;‘::;'::“” « Create EJB 1.1 Integration Object Suppont
—__ Disconnect Macro EJB Integration Object Propartias...
= Global Gersene ¥ CTEANE WEb Services IMEration CObject Suppost
- Wb Serices Integration Object Properies..
 Creats Remate Inbegration Object TE
Remaba Inbagration Object Properdies.. Q
e
<gack | [ Halp

b. Select Create a new Integration Object
c. Click Next

6. Panel: Host Configuration
a. Connection Pooling Information
1. (default) Select Configure a default connection pool
b. Connection Information

1. (default) Select Create a new connection configuration
c. Host Server Information

1. For Server name enter

2. For Terminal Type select TN5250
d. Click Next
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73} 1BM Host Publisher - Host Access _ =[] x|

Fie Edit Macro Terminal Qptions Help

!l Fl m II| HI ‘l.l W

Oiject Configurations Haost Configuration
Macros | Gonnaction Pools | ~Cannection Fooking Information =]
= .., Mew Integration Object Connection pooking raduces response tmea far the client by keeping one or maore connections initialize

=0l ol

and reacy 10 accep! Transactions

- Connact Macro &
& Data Macrn Configura a default connection paol

= Disconnect Macro

> Global Gereans

" Creata anewpool | Advancen Weerl st I

T Bhare ana deting connecton pool TI

~Connection Information

¥ Create a new connection config

5 Share an eflsling connection |."||"|I'|l’_|l|ﬁ

Haost Senver Information

Servar name: FEEMEG.UM.IDM.( o

Tarminal type:
Part number:

L or poal name:

Code pags: = | HIIOptone

Sereen size:

m emablad

DCAS port number §54 .
| |

<pack | Heat » ' Helg |

\

7. Panel: Begin Recording (Begin recording your Connect Macro *****)
a. Click Next
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=|of x|

Oiject Configurations IMaw Bcraan Dafinition
Macros | Connaction Pools |
{8} réew integration Object

o Uniitiad 1
= [ = = 3
safiazel citw ibm.com Screan narne prefic [Sign On
¥E ConnectMacro = L;
m Screend

¥ Data Macro
= Drisconnect Macro
:' Flobal Beraens |

Mest = | Halg

8. Panel: New Screen Definition (Sign On)
a. For Screen name prefix, replace the default screen name with Sign On
b. Click Next
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:‘ﬂ 1BM Host Publisher - Host Access

Filg Edit Macro Terminal Qptions Help

e > mnipl sl ® 3] %]es]:3
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=|of x|

Oiject Configurations #Add Recognifion Crilenion io Scraan Dafinifion - Sign On
Macros | Connection Paals |
ﬂ-rx.eu- Integration Object = Teul area
! Urititizd T Sumber of hiekds

'_;.i gefiasd. ciw ibm.com

T ™ Cursor posilion
%—' Connact Macro

[0 sign on = Amancad -
¥ Data Wacro
E= Disconnedt Macro
& lobal Seraans
« Back Helg

Ch COFVELEST IEM CORF. L9784, LoEd

9. Panel: Add Recognition Criterion to Screen Definition - Sign On
a. Select Text area
b. Click Next
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& s
L7} 1BM Host Publisher - Host Access _ =10] x|
FlE Edit Macro Terminal Options Help
o >imnpllle s 8es:3
Oiject Configurations Taxl Area Recognilion
Macros | Connaction P.:.|:.|5| Diraney @ box armund the beed on the terminal, or tepe the fexd to recognize on this screan -
{8} réew integration Object
& Untitiad Text | Sign om
Bl izerizzd diw ibm com N
S ext Posiion Opbons Options
¥E ConnectMacro : '
Sign On " Test anywhers on the scrasn [tarch this criterion
¥ Data Wacro & Atthe specifiad postion  Row: [I] | Coluranc [35 || |F Case sensitive [ Optional |
= Disconnac Macro 1 | ¢l

:' Flobal Beraens
< Back | Mest = | Halg |

Th COFVELIEST IEM CORF. L9680, [0N

10. Panel: Text Area Recognition
a. Text
1. With your left mouse, draw a box around Sign On in the terminal window at the top
of the screen
b. Text Position Options
1. Select At the specified position
c. Options
1. Select Case sensitive
d. Click Next

file://C:\temp\Rick's%20job\itso_itf sl22.html 2/3/2003



Websphere Host Publisher Implementation

:‘ﬂ 1BM Host Publisher - Host Access

Filg Edit Macro Terminal Qptions Help
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=|of x|

Object Configurations
Bcreen name prafis [Sign Or C

Macros | Connaction Pools |
ﬂ- raew Integration Object Recognition Criteria

Screan Definilion

! Unitithad | Type | Creacripbon

| match | Optional

Bl i=eriz sl diwibm.com
*E connact Macro

m Sign On
¥ Data Wacro

Text at positon Sign On

fEBE Mo

R Cusconmect Macro
:' Flobal Beraens

Th COFVELIEST IEM CORF. L9680, [0N

11. Panel: Screen Definition
a. Click Next
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1] IBM Host Publisher - Host Access B =|o] x|
FlE Edit Macro Terminal Options Help

o> m|np 2 ® &% %] e=]:3]

Object Configurations Cannact Your Session
Macros | Connaction Pools | Host access will now recond the way you interact wilth the systam. Using the larminal below, navigate 1o
fhe point where you are connected to the system, then cllck Mext bo move o the Data Macr

ﬂ- Mew Integration Object
& Untitiad
seriasd diw ibm.com

%_j- Connect Macro

= ﬁ] Sign On.1
E whidamallak]
E bara sl

E Drals Macro = Back Mesd = Helg

- Dizconnact Macro
¥ Global Sereens

12. Panel: Connect Your Session
a. In the terminal window, for Userid type whidemo
b. Pressthe Tab key
c. For Password type guestl and press Enter

13. Panel: Unrecognized Screen (Display Program Messages)
a. Click Yes to create a screen definition

14. Panel: New Screen Definition
a. For Screen name prefix, replace the default screen name with Display Messages
b. Click Next

15. Panel: Add Recognition Criterion to Screen Definition - Display Messages
a. Select Text area
b. Click Next

16. Panel: Text Area Recognition
a. Text
1. With your left mouse, draw a box around Display Program Messages in the terminal
window at the top of the screen
b. Text Position Options
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1. Select At the specified position
c. Options

1. Select Case sensitive
d. Click Next

17. Panel: Screen Definition
a. Click Next

18. Panel: Connect Your Session
a. Press Enter

19. Panel: Unrecognized Screen (OS/400 Main Menu)
a. Click Yes to create a screen definition

20. Panel: New Screen Definition
a. For Screen name prefix replace the default screen name with Main Menu
b. Click Next

21. Panel: Add Recognition Criterion to Screen Definition - Main Menu
a. Select Text area
b. Click Next

22. Panel: Text Area Recognition
a. Text
1. With your left mouse, draw a box around OS/400 Main Menu in the terminal
window at the top of the screen
b. Text Position Options
1. Select At the specified position
c. Options
1. Select Case sensitive
d. Click Next

23. Panel: Screen Definition
a. Click Next

24. Panel: Connect Your Session
a. In the terminal window, type strqm on the command line and press Enter

25. Panel: Unrecognized Screen (DB2 Query Manager for AS/400)
a. Click Yes to create a screen definition
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26. Panel: New Screen Definition

a. For Screen name prefix replace the default screen name with DB2 QM
b. Click Next

27. Panel: Add Recognition Criterion to Screen Definition - DB2 QM
a. Select Text area

b. Click Next

28. Panel: Text Area Recognition
a. Text

1. With your left mouse, draw a box around DB2 Query Manager for AS/400 in the
terminal window at the top of the screen
b. Text Position Options

1. Select At the specified position
c. Options

1. Select Case sensitive
d. Click Next

29. Panel: Screen Definition
a. Click Add

[1] 1BM Host Publisher - Host Access

Filg Edit Macro Terrdnal Oplions Help

@[> mnp sl = o
Object Configurations

Macros | Connaction Pools |

~|of x|

| 8 | e=| 3]

Screan Definilion
Bereen narme prefix: [DB2 M [T Global screen
ﬂ- Mew Integration Object Recognition Critaria

@ Untinzd

Type | Crescriphon | match | optional
seresd diw ibm.com Text at posibon DEZ Quary Managar for AS400 Yes Mo
¥ Connact Macro
z ﬁ] Sign On.1

e [.:i
Ll

ﬁ whidamaollab] |L| J

e

ﬁ [ribar]

5 Display Messages. 1
Duzplay Maszages. |

= (et

£ niain Wenuw 1
= ﬁ] Maen Memu.1
ﬁ strgmjentar]
£ o2 om
& oaz am
¥= Data Macro
j‘ Drigconmic] Macro
¥ olobal Soreenz
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30. Panel: Add Recognition Criterion to Screen Definition - DB2 QM

a. Select Text area
b. Click Next

31. Panel: Text Area Recognition

a. Text
1. With your left mouse, draw a box around the line, 10. Work with Query Manager

profiles in the terminal window in the middle of the screen

b. Text Position Options
1. Select At the specified position

c. Options
1. Select Case sensitive

d. Click Next
=10 x|

:'ﬂ 1BM Host Publisher - Host Access

Filg Edit Macro Terminal Oplions  Help
@b (minpl o v e=]:3
Taxl Area Recognition

Object Configurations
Macros | Connachion Poals | Diranes @ box anound the bexd on fhe lerminal, or type the fexd to recaognize on this screan

8} riew Integration Object

; Untitisd ledt |10, Work with Quecy Manager profiles
seresd diw ibm.com A
= ext Pasition Options Options
%: Connect Macro - .
=& sign on.1 " Text anywhers on the scraen [watch this criterion
& whidarmoltab] & Atthe specified postion Fow: [ Columnnc [6 [¥ Case sensitive [ Dptional |
4] DT

-
&5 (enier] « BaCk | Mead = I Helg |

'} Digplay Messages |
Display Messages. 1 DEZ (meery Benager dor AE/408

= [enter]
‘\% Iiadn Menu.1
=[] tain Menw1
ﬁ stramjentar]
£ ooz om
|t oaz am
= [rata Macro
Cegeonmac] Macr
Hobal Sereens

il

file://C:\temp\Rick's%20job\itso_itf sl22.html 2/3/2003



Websphere Host Publisher Implementation Page 13 of 74

& -
L7} 1BM Host Publisher - Host Access _ =10] x|
File Edit Macro Terminal Oplions Help
@[> mnpsH ® a0 e8]
Oiject Configurations Screan Definilion
Macros | Connaction Pools | Bcraen name prafi [DB2 OM [ Global screen
ﬂ- Mew Integration Object Recognition Critera
! el Type | Degcriphon | mateh | Optional
_ sefesd.diwibm.com Tent at positon D2 Guery Managar for ASI400 Yes Mo r =T -
¥E ConnectMacro gt at posibon 1 0. voek with Quary Manager proflies Yes (Mo = |
= ﬁ] Sign On.1 —l
&5 whidarmoltab] | | ¥ |
=
ﬁ [rlai]

3 Display Messages
Disglay Messages.1
G (et
£y miaan Menw 1
=[] neain Menu 1
E strarnjentar]
4 DBz oM
| ooz om
¥= Data Macro
E Digconnac] Macm

= Flobal Scraens

32. Panel: Screen Definition
a. Click Next

33. Panel: Connect Your Session
a. In the terminal window, type 3 on the command line and press enter

34. If you did not get the Unrecognized Screen panel here, then you did not uniquely define the
previous screen.
Both screens have DB2 Query Manager for AS/400 in the same position on the screen.

If this happened do the following, otherwise go to the next step
a. On the main menu bar, select Macro > Define Screen

35. Panel: Unrecognized Screen (Specify Collection or Library)
a. Click Yes to create a screen definition

36. Panel: New Screen Definition
a. For Screen name prefix replace the default screen name with Specify Library
b. Click Next
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37. Panel: Add Recognition Criterion to Screen Definition - Specify Library
a. Select Text area
b. Click Next

38. Panel: Text Area Recognition
a. Text

1. With your left mouse, draw a box around Specify Collection or Library in the
terminal window in the middle the screen
b. Text Position Options
1. Select At the specified position
c. Options
1. Select Case sensitive
d. Click Next

73} IBM Host Publisher - Host Access

' =10] x|
File Edit Macro Terminal Oplions Help
OISCINEPE T EARSEdESE Y
Tat Area Recognilian

Objact Corfigurations
Macros | Connaction Ponls | Drranee @ box armound the beed on fhe terminal, or tepe the fexd to recognize on this screan
¥ rézw integration Object
& Untitiad Tedt | Specify Collection or Libracy
gefiasd. diw ibm.com
= Options

%:-.m'uet'.ua:ln _ -

=B sign on.1 " Text anywhers on the screan [Wistch this critarion

Test Postion Optons

& whidarmoltab] & Atthe specified posfion Fow: B Column: 28 || Case sensitive [ Dptional

: -
il | ﬂ._l
ﬁ [rilar] = Back | Mead = I Hzlp |
£ Dispray Messages 1
Display Messages.1
= (et
£y iaan Menw 1
=[] neain Menu.1
ﬁ strgmijentar]
£ ooz o
= &l oaz w1
B8 Aenten
£ specir
_ Specify Library

= Dada Macro

R Dizconmecd Macro
t= (lobal Screens

i JTI

39. Panel: Screen Definition
a. Click Next

40. Panel: Connect Your Session
a. In the terminal window, type whidemo in the Library field and press Enter
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41.

42.

43.

44,

45.

Panel: Unrecognized Screen (Work with Query Manager Tables)
a. Click Yes to create a screen definition

Panel: New Screen Definition
a. For Screen name prefix, replace the default screen name with Work with Tables
b. Click Next

Panel: Add Recognition Criterion to Screen Definition - Display Messages
a. Select Text area
b. Click Next

Panel: Text Area Recognition
a. Text
1. With your left mouse, draw a box around Work with Query Manager Tables in the
terminal window at the top of the screen
b. Text Position Options
1. Select At the specified position
c. Options
1. Select Case sensitive
d. Click Next

Panel: Screen Definition
a. Click Next
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=10l x|

Object Configurations
Macros | Connection Paals |
{8} réew integration Object
& Untitiad
seriasd. dtw ibm.com
*E connact Macro
= E] Sign On.1
E whidamallak]
P
ﬁ [l
3 Display Messages
Cisplay Messages.d
G [2nter)
£y miaan Menw 1
=[] main Wenu 1
E strarnjentar]
£ 0Bz oM
= [l oaz a1
& Jenten

=

soph Specify Library 1
= |dll| Specify Library1
& whidsmojenter]
£ wiorkewith Tablas.1
(] ok with Tables.1
& Diata Macro
= Dsconne Macro

¥ clobal Bereens

i 1+

« Back

Caonnact Your Session

Host Access will now racond tha way you intaract wilh the sysbam. Using the lerminal bealow, navigate 1o |
the pointwhers you ane connectad to the system, then click Mext o move to the Data Macro

Net»

Helg

46. Panel: Connect Your Session (End connect macro)

a. To end the connect macro and begin the data macro

1. Click Next
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1] IBM Host Publisher - Host Access

Filg Edit Macro Terminal

@ ||| 1| 2

Qplions  Help

|| &[4 2

3]
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=10l x|

Object Configurations
Macros | Connection Paals |
ﬂ- Mew Integration Object
& Untitiad
senasd diwibm com
¥E ConnectMacro
= E] Sign On.1
é whidamallak]
S
ﬁ [l
fi-ﬁn Display Massage
Dusplay Messages.1
G [2nter)
£y miaan Menw 1
=[] main Wenu 1
é strarnjentar]
£ 0Bz oM
= [l oaz a1
& Jenten

=

soph Specify Library 1
= Specify Library.1
ﬁ whidamo|enier]
£ wiorkwith Tablas
Iﬂ] wiark with Tablas 1
?f— Drata Macro
[ workwitn Tablas.2
F_E— Digeonmect Macr
| ] ]

2

Begin Dala Macm

Iyou wand 1o extract data while recording the data macro, Selec Gather Data’. IFyau want bo recard the

macd withowt estracting data, select To not Gather Data® o make this & nevgational data macro. Click

Mext 1o confinue

& Gather Dala

" B0 ot Gather Data

« Back

Helg

Work stk Qorry Hanager Tables

47. Panel: Begin Data Macro (Begin recording your Data Macro *****)
a. Select Gather Data

b. Click Next
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1] IBM Host Publisher - Host Access ) =|o] x|
£I|E Elﬂ” Eanrn Iﬂrmmai Eﬂﬁl:lﬂs ﬁl,‘.'lp

o> mnp 2H ® &% %] e=]:8]

Oiject Configurations Gather Dala
Macros | Connaction Ponls | Using the terminal, navigate 1o the data you want io caplure and dafine that screen. Alter vou have
= defined fhe data screen, chick Mext o cartinue
- “E_c Connect Macr 5|
= Sign On.1
= whidermnoltab)
&

.

&= [enter]
E;& Ciisplay Message
= [l Disptay Messages 1
i [enie) = Batk | Mo = I Halg
E'.-l% Ptadny Memu, 1
=[] Main senut
&= stromjentar
£ 0B oM
= [B] oaz a1
ﬁ Afarter]
kﬁ Specify Library 1
Specify Library 1
8 whidernofenter
L8 wiorkwimn Tables
Work with Tablas.1
la Wacrn
Bl Wiork with Tables.2
&= Sltab)
& [k_catalog
%T_L_' Digconmic] Macr
-'F_-'--.-:-:l:a Scraens -

i S

48. Panel: Gather Data
a. In the terminal window in the option field,
type 5, then tab to the table field
type jk_catalog and press Enter

49. Panel: Unrecognized Screen (Find Data in Query Manager Table)
a. Click Yes to create a screen definition

50. Panel: New Screen Definition
a. For Screen name prefix, replace the default screen name with Find Data
b. Click Next

51. Panel: Add Recognition Criterion to Screen Definition - Find Data
a. Select Text area
b. Click Next
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52. Panel: Text Area Recognition
a. Text
1. With your left mouse, draw a box around Find Data in Query Manager Table in the
terminal window at the top of the screen
b. Text Position Options
1. Select At the specified position
c. Options
1. Select Case sensitive
d. Click Next

53. Panel: Screen Definition
a. Click Next

54. Panel: Gather Data
a. In the terminal window under column, type product_category then
tab to the test field
b. In the terminal window under test, type eq then
tab to the value field
c. On the menu bar, select Macro, then Insert, then Input Variable

=of x|

1] 1BM Host Publisher - Host Access
eie Edit IR Terminal Options Help
oy (IITHNE ooceod | 5] oo )
re—— Starl Loop Gather Dala
T | 4 rminal, navigate 10 the data you want 1o caplue and dafine thal scraen. Afber vou have

Siop Mam scraen, chick Nawt to continue
)

Pause

B AT
f} Mtadn M1
= [Bll] main enut
&= strgrjentar]
£ 0Bz oM « Back M = Helg
= [§l ez am 1
ﬁ Aarer]
& Eb Specify Librar 1
Speciy Libsary 1
B whidernofenter
£ work with Tabiles
Wiork with Tables.1
- E Crala Macro
= [&ll] work with Tablas 2
= Sltab)
ﬁ jk_catabogentar]
3 Find Data 1
= [B&lll Find Data1
@ procuct_categon
I8 ealat]
E Digconnec] Macro
¥ Giobal Screens -
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Insert Input Variable i|

Yariahle name:

I«aluel

Provide a walue for the variahle to be used while recarding the macro;

lf-'\nimala

8] 4 K | iZancel Help
LA

55. Panel: Insert input variable
a. For Variable name, enter value
b. For Provide a value for the variable ..., enter Animals (uppercase A)
c. Click OK
d. Press Enter

56. Panel: Unrecognized Screen (Display Report)
a. Click Yes to create a screen definition

57. Panel: New Screen Definition
a. For Screen name prefix, replace the default screen name with Display Report
b. Click Next

58. Panel: Add Recognition Criterion to Screen Definition - Display Report
a. Select Text area
b. Click Next

59. Panel: Text Area Recognition
a. Text
1. With your left mouse, draw a box around Display Report in the terminal window at
the top of the screen
b. Text Position Options
1. Select At the specified position
c. Options
1. Select Case sensitive
d. Click Next

60. Panel: Screen Definition
a. Click Next
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61. Panel: Gather Data (You are now at the data screen and ready to start a loop*****)

a. Click the Start Loop icon on the menu bar

5]

.__'I 1BM Host Publisher - Host Access
E'IE Elﬂlr Eanrn Iermma: gpﬁl:ms ﬁl,‘.'lp

=10l x|

Object Configurations

Ol mup -fﬁ_*:"':*ﬂ-'-' = : 3]

dtart Loop -
Macros | Connaction Ponls | rr'l nal, navigate 1o the dala you want 1o caplure and define thal screen. Abar you have

- gefined he data scraen, chick Mewt o continue
8 Wiain Menu.1 2

= Main Menu.1
B stramienter
b 0Bz oM
= [l oaz a1
ﬁ Aeriter]
&% Specity Library 1
= [&lll Specity Library 1 « Back

Gather Dala

M = Helg

&= whidermo|enter]
£ wiorkwith Tables
IE Work with Tablas.1
-'E'_- Drata Macro
= Work with Tables.2
&5 Sltab]
@5 |k_catalogfanter]
£ Find Data 1
= Find Diata.1
& product_categon
B eoltat]
S value
= (et
L8 Display Report 1
Cusplay Report1
%T_L_' Digconmic] Macrm
311_7- Flobal Screens -

i |

62. Panel: Record Loop
a. Click Next

63. Panel: Recording Loop - Begin Loop
a. Select Gather Data
b. Click Next

64. Panel: Recording Loop - Gather Data
a. Click Next
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Oiject Configurations Recarding Loop - Select Data
Macros | Connaction Ponls | Using the mousa and the left mouse butlon, draw & boa an the terminal around the data o be caplured

= | Ifyou are selecing columns of data, do not selectthe calurmn headings. you have siready defined
£ niain wenu 1 similar data o ewdracl, vou can rause that delinition for this screen.

=[] tain Wenu 1
&= stramjentard
£ DB2 oMt —

= H DE7 o 1 ' Belect data on e terrnina|
ﬁ Aeriber] r | j
&% Specity Library 1

= Specify Library1

& whiderno|enter
£ wiorkwith Tables
IE Work with Tablas.1
-'E'_- Crata Macro
= Work with Tables.2
&5 Sltab]
@5 |k_catalogfanter]
£ Find Data 1
= Find Diata.1
& product_categon
B eoltat]
S value
= (et
8 Display Report 1
+- [Blll Dispiay Report.1
Display Repor.2 i
%Luimrra:ﬂjaun =
| | ]

65. Panel: Recording Loop - Select Data
a. (default) Select Select data on the terminal
b. With your left mouse, draw a box around the data in the
PART_NUMBER, PART_NAME, and SALES_PRICE columns
(do not select the column headings themselves)
c. Click Next

66. Panel: Recording Loop - Data Format
a. (default) Select Extract data as a table
b. Click Next
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=10l x|

Object Configurations
Macros | Connection Paals |
[ piain wers 1
B strgrjentar)
%hooezomi
=[] 082 am.1
ﬁ Alenter]
E;& Specify Library.1
= [ll] specite Libeary 1
ﬁ whid@rmo]ener)
£ wiork with Tabiles
Winrkwith Tablaz. 1
= Jé_; Crata Macro
Work with Tables.2
@8 S[tab]
ﬁ ik_c-atabogfentar]
# Find Crata 1
& Fin oata
@8 procuct_categon
&5 ealtat]
B¢ value
ﬁ [aribar]
o &8 Display Repart 1
i Dispiay Report.1
H Cusplay Report 2
%T_L_' Digconmic] Macr
¥= Giobal Screens
1] | ]

|

Entar @ name for this eadraction

Racording Loop - Exdract Data

Table name  roducts]

Helg

67. Panel: Recording Loop - Extract Data
a. For Table name enter: products (lowercase p)

b. Click Next
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Object Configurations

Racarding Loop - Salect Column Mamas

Macros | Connackion Poals | Ifthara are headars for the colurnns of your Bable hat you wish 1o use as column names, select the bad on
— I the terrninal and click the Nest button. Othensise, click the Nesd bufion and default codumn names will be
.EI wiain Meru, 1 providad

@ strgrnfenter
£ DBz oM
=Bl 0Bz oM.
ﬁ Afantar]
,} Specify Librany.
- EI Specifs Libran 1
B8 whicemoleniz
E:ﬁ. Wiinrk wilh Tab
B vworiowsth Tagies 1
= E‘_Qalu Macro
Workwith Tables. 2
=y 5man|
ﬁ E_talalonen
Ry =8 Find Datat
&l Find Data.1
@y product_catag
&8 ealab]

Halg

e value
ﬁ fenbar]
2 =8 Display Report

! % Display Regart 1
- Dizplay Repart 2

= Discannect Macm

= Global Screans -

I T

68. Panel: Recording Loop - Select Column Names
a. With your left mouse, draw a box around the

PART_NUMBER, PART_NAME, and SALES_PRICE headings
b. Click Next
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e Column Names 5 ﬁl

Qne ar mare caldimn hames are
notwalid. Column names must
consist of only alpha-numeric
characters (double byte ar single
byted, the underscore character
(double byte or single byte), or non
Latin double byte characters.
Column names may not begin with
a number, or an uppercase letter.
Automatically convert column
names to a walid format?

69. Panel: Column Names Not Valid
a. Click Yes
1. This changes initial uppercase letters to lowercase and invalid chars to _

70. Panel: Recording Loop-Data Table
a. These column names are only used within the Studio. They are not seen by the end user.
b. Although not required, if you wish to edit the column names you can do the following,
otherwise just click Next
1. Select the column with the left mouse
2. Edit the column names to lowercase number, name, and price, respectively
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File Edit Macro Terminal Qplions Help
Object Configurations f Retond:ng Loop - Data Table
Macros I Cgnnackon Pnnls| Select a column in the able 1o aditits name orwidth, or highlight mutiple calumns 1o mane
= ;[ Inta ane calumn. Chck Mext once all modifcations are made.
=1 [ wsin menu. 1
ﬁ strqmlenter]
£ oez oM
- . Column name  [pART_NUMBER
=+ oB2 oM. a q
ﬁ" Iantar] Column wideh E Left ﬁ. T Right |E T
o . Jicii. i
- Specifiy Librany.
& apecity Library. e I Divide |
=l specits Libran.1 =
By whicemalents < Batk I Helg
£ work with Tabl :
B wionowan Tanies 1 PART_MAME |sALES_FR..
= -E Dala Macra EBeaz, Taddy | 26,00
=1 [l wwiorlcwith Tatles 1 Bear, Panda { 28.00
ﬁﬁ " Bear, Hoala 25,00
=) Sl Dog, Bragle 15.00
&8 F_calalopen Doy, Dachakamd | 1s.00
E ;§ Find Data.1 Dog, Pug | A17.00
o g Find Diata 1 Cat, Marx | 14.00
ﬁ et cat Cat, Persian 21.00
M procct categ Cat, Siamese 22.00
&3 ealtab] Fangarao | 19.00
o e Varan g
- A L 4 -
= [onter] Wenatee 24.00
& Display Report Hombar 15.00
] Display Regart 1
= Display Repaort 2
P —
-?E Disconnect Macro -
Y e PR
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Racording Loop - Finish Dala Exdraction
Macros | Connection Paals |

é strqrmlented 2
@:E:D.Ehf .3“ ' & Finizhed edractng data
B et i Estract more dats
% specity Library
= E Specify Librany. 1
ﬁ whidemalants
: £ wiork with Tab « Batk I
| Work wiith Tables. 1
=9 Dats Macro
= E'ﬂurk wilh Tablas.2
&5 5l
% d :a1-all:-t:|E.r'. ET_H) W b GNLES FRICE FROIUCT _CETIN 0BT
=g Find Data 1 3
E E Find Data.1
ﬁ praduct_categ
&5 =qltab]
e walue
& [entar|
5% Display Report
+ Display Repart 1
% Display Fegart 2
i _£ products
= Digconniect Macm
%—- Global Screans B

I T

Bl » Halg

71. Panel: Recording Loop - Finish Data Extraction

a. (default) Select Finished extracting data
b. Click Next
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Object Configurations Recarding Loop - Parfonm Repalitive Acton
Macrg | Gonnachion Poaols | Liga tha terminal b perform the actions that will be execufing during each cytla aftha loop, then press Nesd

é strqrmlented 2
£ oE2 oM
&l 082 oM.
i Tenter
% specity Library
= E Specify Librany. 1
ﬁ whidemalants
. 8 wiork with Tab « BacH I Hest = Help
| Work wiith Tables. 1
=9 Dats Macro
= E'ﬂurk wilh Tablas.2
&8 5han]
E %_tataloglem
£ Find Data 1
E E Find Data.1
ﬁ praduct_categ
&5 =qltab]
e walue
& [entar|
5% Display Report
+ Display Repart 1
% Display Fegart 2
i _£ products
= Digconniect Macm
%—- Global Screans B

I T

72. Panel: Recording Loop - Perform Repetitive Action
a. Press PgDn to scroll to the next screen
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Object Configurations Recarding Loop - Parfonm Repalitive Acton
Macrg | Gonnachion Poaols | Liga tha terminal b perform the actions that will be execufing during each cytla aftha loop, then press Nesd
é Aanbar] 2

=8 Specif Librany
B speciny Librany 1
iy whitemalarte
3 wiork with Tab
E| Winrk with Tables. 1
= "E Diala Macro
: E""ﬂ?'k"ﬂr Tabbes.2 < Batk I Ned= [ Helg
= e i
ﬁ k_calaloglen
=% Find Data.l
-+ Jilll Find Datat
&5 product_categ
&8 afab]
Bt valug
B8 [enter]
E.% Digplay Riport
. g Dizplay Repart 1
-l Display Repaort 2
2 praducts
= [panedn]
% Display Report
_E Dizplay Repart 3
= Discannec! Macm
:%- Global Screans B

I T

73. Panel: Recording Loop - Perform Repetitive Action
a. After you get to the next screen, click Next
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Object Confguratians
Macros | Connection Paals |
Bl o2 0w =
i Jenter
;’-';§ Specify Library
= E Specifir Librany.1
&5 whitemolznts
b work with Tab
EI Work with Tabkes 1
-1 ¥ Data Macra
= EI"""—"“ wilh Tablas 2
&5 ianl
& v_cataloglent
£ Find Data.t
=l Find Data.i
ﬁ praducl_cabag
&5 =qltab]
e
&= (enter|
£ Dizplay Report
+- 8l Display Report 1
Display Repait 2

& products

&= [pagedn)
=8 Display Report
E Disconnecl acmo
B Global Screans B

I T

Loop Ending Condilions
Balact how (o slop the loop

= Difine @ Unigue Scresn whene e i0op will SI0p

&Elup laap aber Aned nurmtier of iberations [—

= BEEk I Mt = Halp |

PART_WIFETE T9T_

SHLES PRICE FREDUCT_CATINT

74. Panel: Loop Ending Conditions

a. (default) Select Define a unique screen where the loop will stop

b. Click Next
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Object Confgurahons Recording Loog - Define Last Loop Screen
Macros | Connaction Poals | Dafing how 1he loop will and.
Bl ooz om =
i Jenter Mavigate to the final screen of the loop, whare you can defing how and when tha loop will end. Host
.:::§ Specity Librany Publishes will stop reconding while vou navigale 1o 1he |51 Screen ofthe Inog. ANEr you reach 1hal Screen

B chick Maxt o define the |ast screen in the loop
= E Specifir Librany.1

& whidemalznts
b work with Tab
Bl wiork with Tatles 1

=] "&" Drata Macro < Batk I Mest = I Helg
= EI'H-.IIEWH Tahles 2
& skt
&5 j+_cataloglent
£ Find Data.t
= [&ll Find Data 1
ﬁ praducl_cabag
&5 =qltab]
S value
& fenter|
5% Display Report
+ Display Repart 1
g Dizplay Repart 2
& products
ﬁ fpagedn]
E.'ﬁ Display Report
%= Digconnect Macm
B Global Scresns =

¥ F!Trﬂl’tr data after the last screen bas bgen displaned

75. Panel: Recording Loop - Define Last Loop Screen
a. Press PgDn to scroll to the last screen
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Object Configurations
Macros | Connackion Poals | Dafing haw he [oop will and

Bl o2 0w =

i Jenter Mavigate to the final screen of the loop, whare you can defing how and when tha loop will end. Host
. e o wihiile dnnde o ihe 138l & 4 e : -
r-§ Specity Librany Publishes will Stop recording while you navigale 1o 1he [a51 Screen ofihe Ioog. ANeryou reach thal scree

. chick Maxt o define the |ast screen in the loop
= E Specifir Librany.1

& whitemalante
b work with Tab

5 [¥ Estract data after he last screen has been displaed
EI Work with Tabkes 1 =

= "&-_'_L"alahiac.-l:- « Back I Mt = hl
& EI':"'-.Ilkw:r Tahles 2 = = -

Racarding Loop - Define Last Loop Screen

&3 Granl

BE= % _calsloglent

£ Find Data.t

Find Drata

& oroducl_calag

&= =qltab)

S value

E femtar|

£ Dizplay Report
+- 8l Display Report 1

Dizplay Repart 2

j-j products

@& loagedn)
= 5 Dizplay Report

B Disconnecl Macr
= Global Screans -

76. Panel: Recording Loop - Define Last Loop Screen
a. When you get to the last screen, Click Next
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Ull:'IE'it"Jl:'l-':!l urations Recording Loog - Mew Screan Definilion
Macros | Gonnaction Pools |
= [SIL IS SIS Ty
= ’J::?tln.- Librany.i j
??l.'.:'rl:e':l:lren'l:e Screen name prefic [Display Botom
3 Workwih Ta
E Wark wilh Tablas 1 L'S
¥E Data Macro
= E'-"-"DIR with Tables.2
ﬁ filtam|
B r_cataloglent « Back Mest = | Helg
3% Find Data 1
= E Find Dada.1
ﬁ praduct_categ
@ enfab]
¥ walue
B [enter]
;’-';§ Display Report

+ g Dizplay Repart1

=1 il Digplay Riport 2
&7 products
&= (pagedn)

=% Soreeng
=3 Display Report
= =l

| Boreend

2 praducts

= Discannec! Macm
= Global Screans -

77. Panel: Recording Loop - New Screen Definition
a. For Screen name prefix, replace the default screen name with Display Bottom
b. Click Next

78. Panel: Recording Loop - Add Recognition Criterion to Screen Definition - Display Bottom
a. Select Text area
b. Click Next
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Object Configurations
Macros | Connection Paals |
g SR T ikl T
= ’J::?tln.- Librany.i j
&5 whitemafante
% wiarkwith Tab
E Wark wilh Tablas 1
¥E Data Macro
i E'-"-"DIR with Tables.2
ﬁ L
B _rataloglent
3% Find Data 1
= E Find Data.1
ﬁ praduct_categ
iy =qtab]
¥ walue
B [enter]
;’-';§ Display Report

+ g Dizplay Repart1

=1 il Digplay Riport 2
&7 products
&= (pagedn)

=& Displa
=3 Display Report

Bl oi=piay Bottom

s _£ products

= Discannec! Macm
= Global Screans -

@
Racording Loop - Text Area Recagnition
Diraws @ bon around Thie 1exd on the 1erminal, o tepe the 1eal b recognize on Mis screen

Teat Display Repaort

Vext Foshion Upkons Liptions
™ Text amywhers on the screan |'q1=':1rt|'| thiz criterian ;l
* Althe spectfied position Row: L Column: [34 [# Case sansiive [ Opbonal

< Back Hest = Help
| | [

FART_WIFETE T9NT_BSHL

79. Panel: Recording Loop -

a. Text

Text Area Recognition

1. With your left mouse, draw a box around Display Report in the terminal window at
the top of the screen
b. Text Position Options
1. Select At the specified position

c. Options

1. Select Case sensitive

d. Click Next
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Object Configurations i e e e

Macros | Connaction Pools | Seraen name prefi [Display Botom E
o SRV LTS
- Specify Librany.1 = Recognition Criteria

s whidemalgnta Type | Description | Mateh | Optional
. ;.§ wiarkwih Tab [Text at pasition Display Report Yes Mo 7 i
E Wark wilh Tablas 1 4_[1:._
¥E Data Macro e
- E'.-‘IDIRW‘.I‘ Tatles.2 Lal | ¥
ﬁ filtam| j
B _rataloglent
3% Find Data 1
= E Find Data.1
ﬁ praduct_categ
@B eqltab] ) .
:'.':'.: walue FAET _WEETD RET_BSHE GNLES FRICE FRODUCT CETIN 0BT
B [enter]
;’-';§ Display Report

+ g Dizplay Repart1

=1 il Digplay Riport 2
&7 products
&= (pagedn)

=& Displa
=3 Display Report

Bl oi=piay Bottom

s _£ products

= Discannec! Macm
= Global Screans -

80. Panel: Recording Loop - Screen Definition
a. Click Add

81. Panel: Recording Loop - Add Recognition Criterion to Screen Definition - Display Bottom
a. Select Text area
b. Click Next

file://C:\temp\Rick's%20job\itso_itf sl22.html 2/3/2003



Websphere Host Publisher Implementation Page 36 of 74

1] IBM Host Publisher - Host Access ) =|o] x|
FlE Edit Macro Terminal Options Help

@[> mmpi LW | 5| T 6|5
Object Configurations Racording Loop - Text Area Recagnition
Macros | Connackion Pools | Do @ b araund Thee Teod on the lerminal, or tepe thie 1ead to recognize on Mis screen
...l.‘l W SR L “-""'l'j
= Specify Librany.1
ﬁ; whidemalzrits
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Tedt Batten
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- E'-"-"DIR with Tables.2 ' Althe spectfied position  Row: 22 Column: [74 [¥ Casa sansitive [ Optional
& lkan|

@ k_cataloglent | « Back I e = | Halp

3% Find Data 1
= E Find Data.1
ﬁ praduct_categ
iy =qtab]
¥ walue
B [enter]
;’-';§ Display Report
+ g Dizplay Repart1
=1 il Digplay Riport 2
&7 products
&5 [oagedn

=& Displa
=3 Display Report

Bl oi=piay Bottom

s _£ products

= Discannec! Macm
= Global Screans -

82. Panel: Recording Loop - Text Area Recognition
a. Text
1. With your left mouse, draw a box around Bottom in the terminal window in the
lower right corner of the screen
b. Text Position Options
1. Select At the specified position
c. Options
1. Select Case sensitive
d. Click Next
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Object Configurations
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Macros | Connackion Pools |
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a Recognition Critera

= Specify Librany.1
g whidemafanta Tvpe |
;_' § wiarkwilh Tab |t at position
E Work wilh Tables 1 [Text at position
¥E Data Macro
= E'ﬂnmw!r Tables.2 Lad
ﬁ L i
B _rataloglent
% Find Data 1
= E Find Dada.1
ﬁ praduct_categ
= enftat

S value

B [enter]

;’-';§ Display Report
+ g Dizplay Repart1
=1 il Digplay Riport 2
&7 products
&= (pagedn)
=& Displa
=3 Display Report
= =l
Bl oi=piay Bottom
_£ products

= Discannec! Macm
= Global Screans -

Diescripton | Mateh | Optional
- :
Yes Mo P

Display Report
Batiom YES Mo

83. Panel: Recording Loop - Screen Definition
a. Click Next

84. Panel: Finish Data Extraction
a. Select Finished extracting data

b. Click Next
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= Specify Librany.1 j
&5 whitemafante
% wiarkwith Tab
E Wark wilh Tablas 1
¥E Data Macro
= E'-"-"DIR with Tables.2
ﬁ filtam|
B _rataloglent
3% Find Data 1
= E Find Dada.1
ﬁ praduct_categ
iy =qtab]
¥ walue
B [enter]
;’-';§ Display Report
+ g Dizplay Repart1
=1 il Digplay Riport 2
&7 products
&5 [oagedn
;.g Dizplay Bottarr
g Display Report

Display Bottorm 1

i _£ products

= Discannec! Macm
= Global Screans -

Finish Drada Macro

Liga tha tarminal o nandgate back 1o the final screen for this dala macra,

recarding your disconnect rmacro

Click Meaxt whan you wanl b bagin

Halg

85. Panel: Finish Data Macro (Loop back to the first screen of the Data Macro *****)
a. In the terminal window, press F3
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Macros | Connection Paals |
E Drata Mldcro j

= [&l] work with Tables 2
[ Sltab]
{88 ik_catalagenten
38 Find Data 1
= [&l Find Data1
@ product_categoml:
&8 eollat]
T yatug
ﬁ [mrlen
% Display Repont.1
= [&l] Cisplay Report.t
' Display Bofom. 1
s Display Report 2
= Display Repord.2
j';_j prodieels
ﬁ [pagidn]
£ Dizplay Bomom, 1
Eig Ditsplay Report.2
= @ Display Boom. 1
products
i (o)
538 Work with Tables.3
[E] ok with Tables. 3

Disconnect Macro
h_.- L I T
R0

Finish Drada Macro

Liga tha barminal o nandgabe back 1o the final screen for this dala macro, Click Mest whan you seant b begin

recarding your disconnect rmacro

Halg

Work mith fousy Hanager Tables

86. Panel: Finish Data Macro

a. Notice the looping logic in the data macro

b. Click Next
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53 Display Bosom. 1
- 5 Display Repon 2
& oizpiay Repon 2
&2 products

ﬁ [pagedn]

i Display Boflom 1
"g Disglay Repor 2
= [Hll ispiay Battom.1
¢~ produwcs
&8 (73]
;.k Wak with Tablas 3
[ wvors with Tables.3
“E_E Disconnact Macro
[ ] ik weth Tables 4
JF Grobal Screens =

F—

Work mith ouzy Hanager Tables

87. Panel: Disconnect Your Session (Begin recording your disconnect macro *****)
a. On the Work with Tables screen, press F3

b. On the DB2 Query Manager for AS/400 screen, press F3
c. Onthe AS/400 Main Menu screen, type 90 and press Enter
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:‘ﬂ 1BM Host Publisher - Host Access
Filg Edit Macro Terminal Qptions Help

@[> mnip 2E ® &5 5] e=]:3

Page 41 of 74

=|of x|

Objact Configurations
Macros | Connaction Paals |
o Display Report 1 a|
= |:Ij] Dusplay Repar.1
"g Display Bottom 1
o Drisplay Raport 2
= |B] Disptay Repor 2
“E products
&= [panedn]
&3 Display Botiom 1

ﬁ Drisplay Report. 2 ~ Back

Disconnecl Your Bession

Usze the tarminal to disconnact this session. Click hNesd when you hawe disconnechad vour sassion

Helg

|E| Disglay Boflom. 1
_£ products
=
E;@ Workwith Tablas
IEI Work with Tables 3
= :F_" Dizconnect Macro
- IE Wark with Tablas. 4
& ol
&5 o2 o2
& o8z am 2
& (0
8 nain Wenu 2
=[] main menw 2
ﬁ G0lenter]
E;% Sign On.2
] sign on.z
-'F‘- Global Scraens -
i | [

Ch COFVELEST IEM CORF. L9784, LoEd

88. Panel: Disconnect Your Session (Sign On)
a. Click Next
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=|of x|

:“j 1BM Host Publisher - Host Access
i Edit [EERGE Terminal Cptions Help

g | e=|=p|

l

[ D l Bave Inftegration Object
1
|

Macros | C biec] creation is carmplete. Click the Rasl butlon beloss b Sava yaur changas

& vz

& uni Step

J.Ev?- Conneci Macro
= ﬁl Sign On.1
E: whidamaltab]

s=h e

=]
ﬁ [@rilar]
% Display Messages.|
|B| Drizplay Messages.
&= [=nter] £
£ wain Menu 1
=[] tain Menit
E: sirgmienier]
=% 0Bz oM
- [l pBz cw 1
& enten
5 speciiy Librany 1
= [&l] Specity Library.1
&5 whidemolenier]
£ workwish Tables 1
EI Work wigh Tables. 1
-".F_'— Data Macro
= ﬁ] Work with Tables.2
S5 Slabl

< Back | Mest = | Halg

Ch COFVELEST IEM CORF. L9784, LoEd

2

Kl | x]

89. Panel: Save Integration Object
a. Modify the Connect macro for the first user to Logon
b. In the Connect macro on the Sign On screen, highlight the Display Messages jump
c. On the main menu bar select Macro > Insert > Jump to Screen

90. Panel: Jump to screen
a. From the drop down select Main Menu.1 and click OK

amp toscreen x

Select the screen name for the jump destination.

Jump to screen: QLENRROEA ﬂ

oK I i Cancel ' Help l
r‘-\,'

b. Notice the new jump to Main Menu that has been added
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=|of x|

:‘ﬂ 1BM Host Publisher - Host Access
Filg Edit Macro Terminal Options Help

D a3 |||H ® 3| T e=h

Ciject Configurations Bave Inegration Object
Infegration Cbject creation is complete. Click the Max butlon below 1o Sawa your changas

Macros | Connaction Paals |
& vz integration Object =
& Untitied
B i=enesd diw ibm com
*E connect Macro
= ﬁl Sign On.1
E: whidamaltab]

A= ey

=]
&8 [enter] « Back | Head = I Hzlg

E. Display Mossages. |
L% Main Menu 1 [
i

= [B] Dicpiay Messagesh =
ﬁ [antar]
£ wain Menu 1
=[] main Wenu 1
& strormented
5 oez oM.
= & oez am
&= dlenter]
% Specify Librany.1
- :gl Spicif Librar 1
ﬁ whidarmo[erilerd]
E.& Wark with Tagles 1
E Work with Tables 1

= = Dada Macro
TH COPYRIEDT 1B CORE. L1960, L0N0

-_;gl Work with Tables, 2 j

91. Panel: Save Integration Object
a. Click Next
b. Save as
1. File name: MylO
2. Click Save
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\igSave As

Look in: 1 IntegrationObjects

_1EJB
1 Remoteld
Cws

File name:  |MylO Save Q |
Files of type: |Integratinn Chjects (hpi LI Cancel |

c. Integration Object created successfully
1. Notice that the Integration Object, Remote Integration Object files, EJB files, and
Web Services files are all created at this time.
2. Click OK

Creating Integration Object 0 il

Flease wait while the Integration Ohject is generated

Intearation Ohject created successiully
Femauote Integration Object files created successiully
EJB files created successiully
Weh Services files created successiully

oK Dietails...

92. Test what you have done
a. On menu bar select Terminal > Reset Connection
b. In the left frame, highlight the Connect Macro
c. On menu bar select Macro > Play
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5]

L 13 IBM Host Publisher - Host Access ' =|0] x|
e Edit [EETEY Terminal Oplions  Help

oy ' |mlelal i8]

08 Host Access
Macros | i k.
ﬁ. T |l You can now sork with this IMegration Object You can
; Wy gy R eplay the anting macrn, or just parts of i
T Modify the session and conneclion definiions
J-E_‘__' ConnaciMacm o Add conditional paths and loops within the inleractions
= ﬁl Sign On.1 Refer 1o the online Users Guida far more inferm ation on ho b usa the Host Actess agplication i
&5 whidemoltab] rustomize your Integration Objects. Select Mew from the File menu to create a new integration Object
e
ﬁ [@rilar]
5 Display Messages.)
‘\% W zin Menu.1
= ﬁ] Diisplay Messages! =

ﬁ [antar]
E;ﬁ Wl ain Menu.d
= [l main Wenu 1
& strormented
5 oez oM.
= & oez am
&= dlenter]
% Specify Librany.1
- ;EI Spicif Librar 1
é whidarmo[erilerd]
E.& Wiark with Tables 1
E Work with Tables 1
=R Diada Macr
= .gl Work with Tables,2 = STEE AR S A

Kl | x]

d. Watch it play
e. Highlight the Data Macro

(it should already be highlighted)
f. On menu bar select Macro > Play
g. InlInput Required,

"f} Provide Input il

value: l’g\nimalﬁ

ok ] s

1. Type Animals, Sports, or Toddler Toys (each starting with
uppercase letters)
2. Click OK
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1..: Extract Data

10 Bear, Teddy 26.00
11 Bear, Panda 258.00
12 Eear, Koala 25.00
13 Dog, Beagle 15.00
14 Dog, Dachshund 16.00
15 Dog, Pug 17.00
16 Cat, Manx 14,00
17 Cat, Perszian 21.00
138 Cat, Siamese 22.00
14 Kangaroo 15.00
a0 Monkey 20,00
2l Wallahy 23.00

X/

Page 46 of 74

[vl Show extracted data on macro playvback.

Cantinue Stop

h. In Extract Data, click Continue

Click Continue until all data is extracted
Highlight the Disconnect Macro

(it should already be highlighted)

On menu bar select Macro > Play
Watch it play

Nt

-

93. Exit Host Publisher Host Access Wizard
a. On menu bar, select File
b. Select Exit

If you make any mistakes while recording, do the following.
Otherwise, continue with Create Host Publisher Java Server Pages

1. Stop recording, if you have not already stopped
a. On the menu bar, select Macro, then Stop
b. Click Yes to confirm

2. Delete the screen definition error

a. In the left frame, select the screen definition with the right mouse button and then select
Delete. The screen definition is the entry with the icon that looks like a terminal screen with

a check mark on it.
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3. Reset the Host Connection
a. On the menu bar, select Terminal, then Reset Connection

4. Single step through your macros to the last correct spot
In the left frame, select Connect Macro
On the menu bar, select Macro, then Step
Step through each screen until you get back to the screen you made the mistake on
Highlight the last entry of the previous screen
Start recording
1. On the menu bar, select Macro, the Record

P20 T

Create Host Publisher Java Server Pages

1. Start the Host Publisher Studio (if not already started)
a. Navigate through the following:
1. Start
2. Programs
3. Host Publisher Studio
4. Application Integrator

2. Panel: Welcome to Host Publisher Application Integrator!
a. Click Create Application
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i _:‘v'-h:lkornc to Host Publisher Application Integrator!

3. Panel: New Application

a. Enter MyApplEJB
b. Click Next

New Application
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4. Panel: New Application
a. Select I prefer to start with pages
b. Click Next

New Application

5. Panel: New Application
a. Click Import

New Application
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6. Panel: Import HTML Page
a. If not already opened, open the MyApplEJB folder
b. Select MyInputForm.html
c. Click Open

{71 Import HTML Page

Lookin: | _)MyappiEls  >| [ _| J _|

| MylnputFarm.himl
My CutputFage hitml k

File hame: |ru13rlnputF|:|rm.htmI Dpen

Files of type: |Web pages Cjsp, html, bt ;l Zancel

7. Panel: New Application
a. Click Import

8. Panel: Import HTML Page
a. Select MyOutputPage.html
b. Click Open

9. Panel: New Application
a. Click Next

10. Panel: New Application
a. Click Create to create an error page

11. Panel: New Error Page
a. For Page name, type MyErrorPage
1. Click Next
2. Click Finish

12. Panel: Studio
a. On the menu bar, select File > Import > Integration Object
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731 1BM Host Publisher - Application Integrator - MyApplEIR ] =|0] x|

S Eoit oo Creale Oglions  Help
Mew Application... | Application Pages |
Open Application, nputForm | MyCulpulPage MyEmorPaga I
Chosa Application Ls<HEAD "
Save Applicatian page contentType="rtext, /hrul jcharsec=UTF-8" isfrrorPage="rrue™ ercotrPage="Tefa
Copy Application As.., page import="Jjava.text.PateFormat, java.io.StplngWriter, com.ibm.HoatPublishet
Save Page Cirl+5
Save Page As.

ing

Rafrash Page

Transfer to Servar... HTMLUSF Pape
Crﬂa‘tﬂd}EE Archives primeInicError? = “Please wair for inicialization ©o complece or =Tact the Sepwe
Bundiz Application Source
LAng
B—ﬂ tineBusyErTor = “The sysces 13 busy. Please TEY again in & fow seconda.”™
Paga Hierarchy String
;gv:m::alll::-::.'l. = "An error has occurred while processing your cequest. Pl=ase retry
MinpulF orm |3
MyOutpulP age |avring
MyEmorFage |generalEFpar2 = "IE the probles persiscs, CORTACE YoUE Sysress adeiniscrarors and
[5tring
|apecificError = "The Host Fublisher ercor medsage 1a:
|String
|httpSe=sionError = “The Ho=t Publisher error me=sage cannot he retrisved. ™
I
|drring

IhpError = “Host Publisher Exeor™

|String

[

timeTnitBrrorl = “The Server is initislizing or shutting dosm and is currently

ol

13. Panel: Import Integration Object

a. To use EJB support, select the EJB Access Bean jar, MylOAccessl.jar (if you do not want

EJB support, select the 10 jar, MylO.jar)
b. Click Open

_;: Import Integration Object

Lok in: |;|Integratinn0bjects;| | | Eril

(£3 EJB
1 Remateld

File name: |ru13rIDA|:|:eas1 Jar Open

Files of type: |Jaxra Files (jan LI Cancel

14. Panel: Studio
a. Under Page Hierarchy, select MyOutputPage
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b. On MyOutputPage, position the cursor on the line following
<I---Insert your integration object next--->

c. On the menu bar, select Insert then Insert Integration Object

d. Click Yes to insert at the cursor

=10l x|

Application Pages
Ry Form MyOutpuiPage | wyEmorPage |

<HETA hrrp-equiv="Conrent-Type” CONCent="text/htnl: chatset=TUTF-8">
<META HTTP=EQUIV="Contenc=-Type™ CONTENT="teXT/htul! charset=130-BE50=1"x
CTITLE>JE Toys</TITLE>

& JHEATYS

[<BODY bgrolor="§FFFFFF texce"§000000">

(<P align="left"><IMF SEC="3jk loga_top.gif™ >

|chEsanbap
|1 ==cc=Ingert your integrarion object nexC---=--==3
(< /BOD,
| ] & :-\'.')'HTH]..'.&
Paga Hierarchy |

lnpulF omm

MrdutputFape

MyEmarFage

15. Panel: New Integration Object
a. Highlight IntegrationObject.MylOAccess1
b. Click Next
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New Integration Object x|

Selectihe Integration Object you wish to 2dd 1o the page. Click Browse to search for additional Integration Objacts to
impaort into the application, Ifyou are using object chaining, ensure that there is an Integration Object whose end state
matches the starn state of the Integration Object you are adding.

Integration Objects:

nte |_| rationObiect MylOACcess]

Browse. .

Nexts Finleh Cancel Help

16. Panel: New Integration Object
a. Under Field, select setVValue
b. Click Define

New Integration Object x|

The Infegration Qbject felds listed below require input data.

1. Click Define to specify how that data 15 1o be obtained.
2. Click Mext whan you have finished defining the input data.

Integration Objects:

Field Page Source

Define [ I

=Back Mext= i Cancel Help

17. Panel: Insert an Input
a. Select A new input field
b. Click Next
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18. Panel: Insert an Input
a. Select Create a new form
b. Click Next

19. Panel: Insert an Input
a. Select Use an existing page for the form
b. In the field select MyInputForm
c. Click Next

20. Panel: Insert an Input
a. Select Radio button list
b. Click Next

Insert an Input

21. Panel: Insert an Input - Radio button list
a. Click Add Label
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Insert an Input - Radio button list i il

For each control tem, Add labels and associated values to be used for the label You may also Edit or Remove exlsting
labeal definitions. Click Mext when you wizh to continue defining your application.

Labels:

Labels | Values B

Add Label i

=S ET |

EETHO eI L] |

=Back ek [ Firilsh | Cancel Help

22. Panel: Item Label and Value
a. Set both Item Label and Item Value to Animals
b. Click OK

Item Label and VYalue : i|

Add a lakel and its associated value.

[tern [akel:

iﬂ\nimals

[tern value:

lﬂmimala

0k P Cancel
Wy
c. Inthe same manner, add labels for Sports and Toddler Toys
d. Click Next
e. For Type a descriptive label ..., enter Select search value ...
f. Click Finish

23. Panel: New Integration Object
a. Click Next

24. Panel: New Integration Object
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a. Using ctrl-left mouse select all of the following
1. getProductpART_NUMBER
2. getProcuctpART_NAME
3. getProductsALES_PRICE

b. Click Render

Mew Integration Object =l il

1. Select one or more Integration Ohject outputs.

2. Click Render to specify how the output is to be represented on the page. To create a table, select more
than one output that supports multiple values.

3. When you have finished rendering the data, click Next to preview the pages you have created.

Integration Objects outputs:
Render
i)
getProducts
e T 0e=1 [N T=1 [2innla
.
gack | Net= | rricn | cancel Help

25. Panel: Insert Output Control
a. Select Table
b. Click Next

26. Panel: Insert Output Control - Table
a. For a descriptive caption, enter My Search Results
b. Click Next

27. Panel: Insert Output Control - Table

a. Select productspART_NUMBER
b. Click Modify
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Insert Output Control - Table x|
1. Modify the column names for the table by selacting each column name and clicking the Modifty bution
2. Usze the Move Up and Move Down buttons o reordar the columns.
3. Click Finlsh when you are satisfied with the arrangement.
Column names:
productzpART _MNUMBER Modify
productspART_MAME o
productssALES_PRICE
lerd=l el |
Miove D own |
=Back Finish | Cancel Help

28. Panel: Edit Column Name

a. Enter column name of Item #
b. Click OK

Edit Column Mame :

hodify the column name.
Jitem #

OK Zancel
40

29. Panel: Insert Output Control-Table

a. Select productspART_NAME
1. Click Modify

2. Enter column name of Item
3. Click OK

b. Select productssALES PRICE
1. Click Modify

2. Enter column name of Price
3. Click OK
c. Click Finish

30. Panel: New Integration Object
a. Click Next
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31. Panel: New Integration Object
a. To preview, select MylnputForm
b. Click Preview

‘a JK Toys - Microsoft Internet Explorer ) = I:llil
| Fle Edt Veew Favertes Took Heb Jroi -2 -@@d Aseacn [l
| Adckress [ ] C-\HestPubStUdic\emp My InpUtFer . hem x| @0
=l
The coolest toystore around!
Select search value ...
& Animals
 Sports
© Toddler Toys
Submit i
i

] Dore

32. Panel: Studio

Go from your browser back to the Studio
Select MyOutputPage

Click Preview

Close your browser

Click Finish

T Q0D
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73} 18M Host Publisher - Application Integrator - MyApplEIE _ O] x|
File Edit |nsem Creale Options Help
Avallable Objects Application Fages |
MyinpulForm  MyOUpUtPage | MyErorPage |
+ Q integrationObisctMiOReces | | aligne"lefr™><ING 3RC="ik_logo_top.gif™ > B
[<brrx&nbap ;
Cim====INaeEt FOUE integration object NEEf========k

|<jspruselean 1d="Myllhcceszl" type="Integrationlbject.BMyllAccessl™ class="Integoat
I<jmspt setPraoparty name="ByIlAccessl™ propecty="7*" />

</ jspiuseleans:

<% MpIlhccasal, serHPubSrarePoolNams { "MeI0™): %>

<% AylDAccasal, doHPTEansaction(Lequest, Ee3ponse): x>

(<PxAF Search Pesilta<TABLE BEOFDER-<TEIDY>
<TL>

| | —'j cthrItes #</ths
Faga Hierarchy <thrItemd /ths
|cthxPrice</th>
= l:'_“l Mn pulF anm CSEEE
e [ MydiiuiPane les
[ MyEmorFage |far {ine 1del = 0 1dxl <= 2147493647: 1dwlas)(
ey {

bk

String str =
Lt +vn”™ +
"etds" + MylOkccessl.getProductspART WUMBER (idkl) + ™\n" +
Torde" + MyLOAceesal.gerProductsphRT HAME (idwl] + ™wno" +
morde'” + HyIOAccesal.gerProductasAlES_PRICE (Ldkl) + ™wn™ +
TLSEDT £ TA\RT

4 y i

33. Panel: Studio
a. Inthis lab the last line of the results is a line the reads END OF DATA
b. If you would like to remove this line from the results that are displayed, do the following
c. Under Application Pages, select the MyOutputPage tab
d. Edit MyOutPutPage to add the following lines of java code where shown in the image
above

if (MylOAccessl.getProductspART_NUMBER(idx1).indexOf(""E N D") I=-1) {
break;

}

34. Panel: Studio
a. Save your application
b. On the menu bar, select File
c. Select Save Application

Transfer your Host Publisher application to the server
1. Panel: Studio

a. On the menu bar, select File
1. Select Transfer to Server
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'__} 1BM Host Publisher - Application Integrator - MyApplEIR
W Edit |nset Creale Ogtions  Help

Page 60 of 74

MNew Application...

| Application Pages |

Open Applicatian, - MyOutputPage | MyErrorPage |

Lhose Application aligm="1eft™><ING JRC="9E_logo_top.giL™ = =

Save Application [ onbap .

Copy Application As..,

Save Pape Cirl+5 [-=--Insert your integration oblect NeXt-=-===-- =]

Save Page A3,

Refresh rpruselesn 1ds"Myllhcoes=l" types"Incegrationlbject.ByllAccessl™ classs®Integeat
_._..__‘._m -sprsetProperty name="Hylliccessl™ propecty="*" />

Impor L4

mnrrmueaal. serHPubSrartPoollane ("ByI0~) ; %=
Create JIEE Archives

=piuseleaans

ApIDAccesal, AoHPTEaR2action [Eequest, Esspop=e) r >

Bundla Application Source
= My Search Pesults<TAELE EORDER-<TEODY:
— -
Kl I Al cthoteen de/tho
Paga Hierarchy |« tbo Tteme /o
|CthaPrice</thy
= [ mnputF orm lesre
- [ McidiiitFane <
[ myEmarPage for (inc didel = 0 idel <= 2147483647 idsles]|
try |
it [AyIDAcceaal.getFroductapART NUNEER(1dxl).indexDE(™E W D"] != =1} { by |
bErak;

'

String stc =
"Lt ™ +
“gtdr" + MylOAccessl.getProductspART WIMBER(idxl) + ™\n" +
Torde" + MyLOAceessl.gerProductsphRT HAME (idxl] + ™wa" +
"Lndr" + HYIOAccesal.getPooductasALES PRICE(Ldxl) + ™™ +
ST 4+ TVRT

k>

_tI;I

sl |

a. Select localhost

2. Panel: Transfer to Server

b. Check Include Remote Integration Object support in the application archive
This is only used in this lab to show a sample of how data can be extracted in

XML format.
c. Click Next
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Transfer to Server i x|

Selectihe Host Publisher Servars to which you want to transfer. (Click ‘Server Info..' (o modify the list
of defined Host Publisher Servars)

Semers:

Select All ]

Server Info... |

Connection Fools... I

[+ include Remote Integration Object support in the application archive

Mext= Firiis Cancel Help

3. Panel: Transfer to Server
a. Click Transfer
b. Check status
c. Click Finish

4. Panel: Studio
a. On the menu bar, select File
1. Select Exit

Deploy your Host Publisher application on the server

1. If your lab machine is using WebSphere Application Server Advanced Single Server Edition, skip
this section and go to the next section, Deploy Host Publisher application on WebSphere
Application Server Advanced Single Server Edition

2. Start IBM HTTP Server and WebSphere Application Server
a. Navigate through the following:
Start
Settings
Control Panel
Administrative Tools
Services
Right mouse click on IBM HTTP Server
Start
Right mouse click on IBM WS AdminServer 4.0

Nk wNdE
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9. Start
10. This may take a couple of minutes on these lab machines

3. Start WebSphere Application Server Administrator's Console
a. Navigate through the following:
1. Start
2. Programs
3. IBM WebSphere
4. Application Server 4.0 AE
5. Administrator's Console

4. Panel: WebSphere Advanced Administrative Console

Page 62 of 74

a. Expand WebSphere Administrative Domain
b. Expand Nodes
c. Expand Enterprise Applications
d. Right mouse click on Enterprise Applications
e. Select Install Enterprise Application
"% Websphere Advanced Administrative Console = Diﬂ
Consobe View Tools Hel
e 00 P x& B2
=4 WebSphera Administrativa Domain I Marme | Mode |
£3 Wirtusl Hosts i
3 Server Groups M1 HPAdmin wehlidermnd
=0 Modes [ HPDae whidemod
= whidemod 1 xmiGatewsy whidemod
#+-0O Application Semvers
= B Oarer: Sorvers General ] iserRole Mappings | Runas Mappings |
: g Ld;iul?:;:li-lld_ﬁﬂmmi m— Enterprise Applicaiion b name: “l‘lﬁhiﬂﬂmﬂ-‘_ﬁﬂmlﬁ'mﬂﬂﬂ
+-3 HFDoc
= 3 amiGateway
+ 3 Resources
| | v |
Crplions_ |

'JH'B-I Tlm:a ] : Euerlhlas_s% _ | Sounce I_J

B 21002107 .. Command *MeApplearracursive_namova® completed succe...
E 21002107 .. ADMRZI0LE\Wab Servar Plugin Confip. The adminisbative .. com.ibm.ajs.sm beans Moduled... j
——

Detalls... I

Claar

5. Panel: Specifying the Application or Module
a. Select Install Application
b. Click Browse
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" Install Enterprise Application Wizard

Specifying the Application or Module
Specity the application(EAR file) or module(JAR or WAR file) that vou want to install.

Ifyou install a stand-alone module, you must specify a new application name,

Browse for file on nodea: “lwhidamod

i+ Install Application (~.ear)
Path: 1
Application name: |

™ Install stand-alone module (“war, © jat)

Cancel

Help | = Haol | Mlexd Finlsl

6. Panel: Open
a. Browse to installableApps\HostPublisher

b. Select MyApplEJB.ear
c. Click Open
d. Click Next

"Wl Open [

Lookin: |1 HostPublisher =] | | ﬁl

, WvApplEJBR ear

File name: |MyAppIE.JEI.ear Open R |

Files oftype:  |JARSVARSIEARS (war, ear,jan |  Cancel |

7. Panel: Mapping Users to Roles Application Server: HostPubServer

a. Click Next
8. Panel: Mapping EJB RunAS Roles to Users
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a. Click Next
9. Panel: Binding Enterprise Beans to JNDI Names
a. Click Next
10. Panel: Mapping EJB References to Enterprise Beans
a. Click Select EJB

" Install Enterprise Application Wizard

Mapping E.JB References to Enterprise Beans
Each EJB reference defined inyour application must be mapped to an Enterprise
bean

Enterprise bean. For more information on the EJB Reference, click the Details button.

E.J8 Reference Module JHDI Mame Detalls .. I
e byApplEJBEEJE
SelectEJB... D !

%,J Select an EJB Reference from the list below and click the Select EJB button to select an
= P

Help | | = Hack I fHext Einlsf Cancel

11. Panel: Select EJB
a. Expand MyApplEJB.ear
b. Expand MyApplEJBEJB.jar
c. Select MyApplEJBEJB
d. Click OK
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Select EJB g

* Selact a bean in this domain

b [

= _14 WebSphere Applications
=4 MypplEJB ear

=24 WyApplEJBEJD jar
L Wy pplEJBEJBE

L] whidernod_samplespp

H- ] HPAdmIn

- HPDac

) EmilGateweay

Eigas

= Type JMDI name for this elb ref for foreign domain _'|

Ok [T: | Applky | Cancel [ Help |

12. Panel: Mapping EJB References to Enterprise Beans
a. Click Next
13. Panel: Mapping Resourcre References to Resources
a. Click Next
14. Panel: Specifying the Default Datasource for EJB modules
a. Click Next
15. Panel: Specifying Data Sources for Individual CMP Beans
a. Click Next
16. Panel: Selecting Virtual Hosts for Web Modules
a. Click Next
17. Panel: Selecting Application Servers
a. Select MyApplEJBEJB.jar
b. Click Select Server
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"w Install Enterprise Application Wizard

Selecting Application Servers
Specity the application server wheara you want to install modules contained in yvour
application. Modules can be installed on the same server or dispersed among
several saners.

senmer on which to install the module.

M ocule plication Serer Select Senver.. R!
MyspplEJBEJS jar

?J' ~ Selecta module in the list below and click the Select Server button to select the application
=l

hvApplEJE wear

Help | | = Back I e Firieh Cancel

18. Panel: Select a Server or Server Group
a. Select HostPubServer
b. Click OK

Select a Server or Server Group

Application Semver;

x|
Default Serverfwhidermod) O [: |
HostPuhSereriwhidemod)

Cancel

Sener Group:

19. Panel: Selecting Application Servers
a. Select MyApplEJB.war
b. Click Select Server

file://C:\temp\Rick's%20job\itso_itf sl22.html

2/3/2003



Websphere Host Publisher Implementation Page 67 of 74

"w Install Enterprise Application Wizard

Selecting Application Servers
Specity the application server wheara you want to install modules contained in yvour
application. Modules can be installed on the same server or dispersed among
several saners.

I J ~ Select a module inthe list below and click the Select Server bution to select the application
l-«g : g server onwhich to install the module.

W ocule | Application Server | Select Eer\fer...[\g
MyAppIEJBEJE jar HostPubSereriwhidemaod)
yibppl EJB wear

Help | | = Back I e Firieh Cancel

20. Panel: Select a Server or Server Group
a. Select HostPubServer
b. Click OK

Select a Server or Server Group

Application Semver;

x|
Default Serverfwhidermod) O [:l
HostPuhSereriwhidemod)

Cancel

Sener Group:

21. Panel: Select a Server or Server Group
a. Click Next
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"w Install Enterprise Application Wizard

Selecting Application Servers
Specity the application server wheara you want to install modules contained in yvour
application. Modules can be installed on the same server or dispersed among
several saners.

I J ~ Select a module inthe list below and click the Select Server bution to select the application
l-f@ s ™| server onwhich to install the module.

Module | Application Server |

MyAppIEJBEJE jar HostPubServeriwhidemaod)

Wyip plEJB wear HostPubServerfwhidemod)

Help | = Back I Mext = &I Firieh Cancel

22. Panel: Completing the Application Installation Wizard
a. Click Finish

23. Panel: Deploy
a. Click Yes

"4/ Deploy _ il

@ Application code necessary for installation has not been generated. Generate code now?

e ] mo |

24. Panel: Deploy
a. Click OK
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"4/ Deploy : x|
Deployed module location: hpsxmygpp|EJE|_dep|na_,red,ear
Winrking Directony: preltppSeneninstallablefpps

Dependent classpath: |

[ Code generation only

[ Werify archive
RMIC options: |

Database type: [DBZUDBWIN_VT2 |

Database narne: |

Schema harme: |

QR [: | Cancel

25. Panel: Information dialog
a. Click OK

"% Information dialog ﬂ

Command "Enterprizefpp.install" completed
successiully.

26. Panel: WebSphere Advanced Administrative Console
a. Right mouse click on MyApplEJB.ear
b. Click Start
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"Wl Websphere Advanced Administrative Console = Elﬂ
_Consobe View Tools Help _

| e |
&0V XE&| 9|

= ﬂ YienSphera Sdministrativa Domain E Mame I
Wigh Modules

53 vitusl Hosts
3 Server Groups

=HE Nodes
= whidemod
+ 0O Application Samwvers
0 Generic Semvers
B e ide General | Userfale Magpings | Runas Mappings |
+-0 whidemoed_sarmpledps Entarprize Application nama: =
-0 HPAdmin et lonE B
+ 0O HFDoc
#= 3O smlGateway
=20
3 EJB Modul  Find.,
8 Ve Modu
+
3 Resounces Stop
Force Stop
o
Exporl Application... - —
Show Status goete | meset | wep |
= = View Deployrnent Descriplor T e 1 Options__ |
%—Imm—l —currr . Properties

' [
E 21002 303 .. ADMRZI0LEWWab Servar Plugn Confip. The administrative .. com.ibm.ejs.sm beans Moduled... Deralle...

E 21002 303 .. Command "Entengrisesppinstall’ completed successfully. - Clear I
I

27. Panel: Information dialog
a. Click OK

"% Information dialog ﬂ

Command "MyApplEJB. ear start” completed
successiully.

28. Panel: WebSphere Advanced Administrative Console
a. Right mouse click node name
b. Select Regen Webserver Plugin
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"%t Websphere Advanced Administrative Console
Console View Tools Help

e o 0Y X&|l 9|

=10l x|

Page 71 of 74

Name

=HE Nodes
=N i
=0 Applice Find._ |.

= ﬁ YienSphera Sdministrativa Domain
03 Virusl Hosts
3 Server Groups GRARHE SEMErs

i T i s Praviders | URL Providers | JOBC Providers | J2C Adapters |
! “  Force Sfop
B Generi Proiotiat
=3 Entarprise Ap E
-3 whidemeod | EEEELTE
4 [ HPasmin - Stopfor restat
-3 HPDoc Ping
01 wniGalew e

Ca..
-1 MyApplEJE
AR oo eicornr Py

=8 "|=f,|.....-.- ]

+
¥
+
¥

F 3 Resources

Holp

[

03 wen b ETTEEE
| o | meser |

Propadias
Soura |

JEE Time | Event Mess |
pr.L o mmmm‘m'ﬁ‘m z
i M :J

E 21302 11:24.. Command “MyApplEJE. ear.starl compleled successfully.
G 21302 11:24.. SRVED1691: Loading Yeb Module. MyipplEJE vear.

com.ibm.serdatangine. SendetEn... j

Options_ |
Detalls.. |

Claar

29. Go to section, Access Host Publisher application from your desktop browser

Deploy Host Publisher application on WebSphere Application Server Advanced Single

Server Edition (WAS_AES)
1. Start WAS_AES
1.1. On the desktop click WAS_AES startServer

2. Start WAS_AES Admin Console

2.1. On the desktop click WAS_AES_AdminConsole

2.2. For User ID enter admin

2.3. Click Submit

2.4. If you get the temporary configuration file Alert message, click OK
3. Install your Host Publisher application

3.1. In the left frame, expand Nodes

3.2. Expand the nodename
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3.3. Click on Enterprise Applications
3.4. Enterprise Applications: click Install
3.5. Application Install Wizard:

3.5.1. Specify the Application or Module located on this machine ...., next to Path click
Browse

3.5.1.1.  Browse to c:\WebSphere\AppServer\installableApps\HostPublisher\
MyApplEJB.ear (or MyAppl.ear depending on which you built)

3.5.1.2. Click Next
3.5.2. Binding Enterprise Beans ... click Next (EJB only)
3.5.3. Mapping EJB References ... click Next (EJB only)
3.5.4. Specify Virtual Host names ... click Next
3.5.5. Confirm the following: click Finish
3.6. Enterprise Applications: click Plug-in configuration needs to be regenerated
3.7. Web Server Plug-In Configuration: click Generate
3.8. Enterprise Applications: check your application then click Start
3.9. Enterprise Applications: click Configuration needs to be saved
3.10. Save Configuration:
3.10.1. Be sure Save is selected
3.10.2. Click OK
4. Close WAS_AES Admin Console
4.1. Close the browser
5. Stop WAS_AES
5.1. On the desktop: click WAS_AES stopServer
6. Start WAS_AES

6.1. On the desktop: click WAS_AES startServer
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Access your Host Publisher application from your desktop browser

1. Start Internet Explorer

a. In Favorites\Links, select HPub_MyApplEJB
the url is
http://yourServername/your AppName/yourPageName.jsp
for example, on the lab machines it is
http://localhost/MyApplEJB/MylnputForm.jsp

b. Select the search value of your choice

c. Click Submit

4} . Toys - Microsoft Internet Explorer 3 - O] x|
| Fle Edt WView Favorites Took Hep | #bae ~ = ~ @ [ & | DSearch ‘-
|Adchess €] hitp:/ focahostiMyAppETBMyInputForm. fsp =] feo
=l
The C00lest toystore around!
Select search value ...
= Animals
- Sports
© Toddler Toys
| Submit|
L | k4|
&) Dore || ¥ Locd nranet .

2. Watch it run

file://C:\temp\Rick's%20job\itso_itf sl22.html 2/3/2003



Websphere Host Publisher Implementation Page 74 of 74

e

My Search Resulis
Ttem#  Item  Price -
10 [Bear, Teddy  26.00
11 [Bear, Panda  28.00
12 [Bear,Koala  25.00
13 Dog Beagle 15.00
14 Dog, Dachshund 16.00

15 [Dog, Pug 17.00

16 |[Cat, Manx 14.00

17 |Cat, Persian  21.00

18 |Cat, Siamese  22.00 =
@] Done | i_ELurxmm 4

End of lab
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